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1 INTRODUCTION

This document describes how to utilize the Email Manager (eMgr) Client to add Outlook or Lotus Notes

items to a FileNet repository. An overview of how use the application is provided in the Using the Client
section, and subsequent sections provide details on the features available in the Email Manager Client.

Note: screenshots may not reflect the view available in the Email Manager Client for each email client
supported.
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2 USING THE CLIENT

This section provides an overview of how to use the Email Manager Client to add items to a FileNet
repository. Adding an item to a repository consists of selecting an item in the email client, choosing the
Add to FileNet option, and selecting or creating a Profile to use to add the item to a FileNet
repository.

1. Select Items in Mailbox

To add Mailbox Items to a FileNet repository, first select the item or group of items in the mailbox. If
Outlook is being used email, calendar items or tasks may be selected. If Lotus Notes is being used email
may be selected.

2. Choose Add to FileNet
Once the items have been selected click the Email Manager Toolbar button to begin the add process.

The Select Profile screen will be opened after choosing this option.

il

Figure 1 - The Email Manager toolbar button

3. Select a Profile

In the Select Profile screen, select the Repository in to which the selected items should be added. Login
to the repository using the FileNet login screen that will be displayed. After selecting the Repository,
select the FileNet Group that should be used. A list of Profiles for the selected Repository will be shown.
An existing Profile may be selected, or a new profile may be created. After selecting a Profile, the items
will be added to FileNet using the selected Profile. If the Profile is configured to display before adding to
FileNet, the Profile content will be displayed in the Apply Profile screen and may be updated as required.
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3 CONFIGURE EMAIL MANAGER CLIENT

The Configure Email Manager Client screen is used to update specific settings in the Email Manager
Client and manage Email Manager Profiles. The screen may be opened using the Tools ->
Configure Email Manager Client menu option in Outlook, or in Outlook, Lotus Notes and
GroupWise by clicking the configure Email Manager Client link on the Select Profile screen.

& Configure eMgr Options |

—Opkions

[T always use this profile: I j

eMar Web Services location
Ihttp:,l',l'e-:wtestE,l'ecwwspEiSD,l'ecwwspEi.asmx?'-.-'-.-'SDL

Object Store:

|ECw RM Docs |
—Profiles
Milame | Aiccess | Created By | Prampk | Create...
Development Email  Owner Adrniniskrator Yes
Marketing Email Curier Adminiskrator Yes Edit...
Cuplicate, ..
Remaoyve
J | i

about, ., Close

Figure 2 - Configure Email Manager Client Screen
The following is a description of the configuration options available.
Delete Item After Adding to Repository

This option is used to specify whether or not an mailbox item should be deleted after is has been added
to a FileNet repository. If this option is selected, mailbox items added to FileNet will be deleted. If this
option is not selected, the items will remain. This option may be overridden in the Select Profile screen
when adding an item to FileNet.

Prompt to Capture Sent ltem

If this option is selected, when a user send an email, a prompt will appear asking the user if the sent
email should be captured.
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Always Use This Profile

This option is used to specify whether a specific profile should always be used when adding email to the
FileNet repository. If this option is selected, the combo box next to the option box will be enabled and a
profile may be selected from the list. If this option is not selected, the Select Profile screen will show and
a profile must be selected from the Select Profile screen.

Email Manager Web Services Location

This field specifies the location of the Email Manager Web Services. The Email Manager Web Services
are used by the Email Manager Client to communicate with FileNet as well other Email Manager
components. The address is shown on this screen for informational purposes only and may not be
updated. If the Web Services location needs to be changed, it must be changed by the system
administrator.

Select a Repository/Object Store

Select the repository for which Profiles should be displayed. Once a repository is selected, a list of
Profiles that have been configured for that repository will be shown. The first time a repository is selected
a FileNet login screen will be shown. After logging into the FileNet repository, the Group combo-box will
contain a list of FileNet groups the current user is a member of. The Group will default to the user’s
default Group.

Group

Select the FileNet group that should be used. All groups that the current user belongs to in the selected
repository will be shown. Changing the group will impact what information is displayed in the Profile
Create/Edit screen.

Profiles

This section lists all Profiles that are available for use. The following options are available for Profiles. The
user must have sufficient permissions to modify a profile.

Create...

Selecting this option will open the Create Profile screen which will allow for the creation of a new
Profile.

Edit...

Selecting this option will open the Edit Profile screen which will allow for the editing of an existing
Profile. Only those Profiles that have been created by the current user may be edited.

Duplicate...

Selecting this option will open the Create Profile screen which will allow for the creation of a new
Profile based on an existing Profile.

Remove

Selecting this option will remove the selected Profile. Only Profiles that have been created by the
current user may be removed.

About

Click the About button to show About dialogue, which will information about the application version.
Close

Click the Cclose button to close the Configure Email Manager Options screen.
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4 SELECT PROFILE

The Select Profile screen is shown when an item or set of items in a mailbox are selected and the Email
Manager toolbar button is selected.

& Select Profile... |

Select a Object Store:
|ECw rM Docs R

[~ Celete selected item(s) after adding to repository

Select Single Profile | Select Profile Per Tkem

Marme | Prompk |
Development Email Yes
Marketing Email Yes

Configure eMgr Qpkions Select Profile. ..

The following is a description of the options available on the screen.
Select a Repository/Object store

Select the repository that the selected mailbox item(s) should be added to. Once a repository is selected,
a list of Profiles that have been configured for that repository will be shown. The first time a repository is
selected a FileNet login screen will be shown. After logging into the FileNet repository, the Group combo-
box will contain a list of FileNet groups the current user is a member of. The Group will default to the
users default Group.

Group

Select the FileNet group that should be used. All groups that the current user belongs to in the selected
repository will be shown. Changing the group will impact what information is displayed in the Profile
Create/Edit screen. Groups are only shown for FileNet Content Services.

Select Single Profile

This section lists all Profiles that are available for use. The selected Profile will be applied to all items
selected in the mailbox for capture.
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Select Profile Per Iltem

This section lists all items that have been selected in the mailbox (including attachments for each item)
and allows a separate profile to be selected for each item or attachment. Select an item by selecting the
checkbox next to the item name. Select a profile for an item by choosing a profile from the combo box
next to an item. If profiles are configured to “prompt” a separate profile prompt will appear for each item
selected.

Select Profile Button

Selecting this option will use the selected Profile(s) to add the selected mailbox item(s) to FileNet. If the
Profile is configured to prompt after being selected, the content of the Profile will be shown before the
selected mailbox Item(s) are archived.

Cancel Button

Selecting this option will close the Select Profile screen and cancel the “add to FileNet” action.
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4.1 Apply Profile

The Apply Profile screen will be shown if the Always show profile before adding to
Repository option is selected in the Profile, in the Advanced section. The contents of the profile will be
shown and some of the data may be edited.

& Apply Profile |
Profile Mame: [+ Capture Email
|Deve|u:upment Ernail Edit Ernail Format. ..

[# Declare 2s record [T Capture attachments as individual Files
In captured email File:
¥ Enable shorkouks
Edt ShorteLt Ot i~ Leave attachments in email
it Shorbcut Cptions. . .

% Remove attachments From email

| Document Indesxing | Record Declaration |

Class:
IEman j [T | Link captured files
Folder ko file documents
IDu:u:s a00 |
Property |'u'a|ue | =
Document Title Project Update o
Fram From Address|Display

To To Address/Display

Zr CC AddressfDisplay

Subject Project Update

Sent On Sent Dake (UTC)

Received On Received Date (UTC) -

K Zancel Bdvanced ==

Figure 3 The Apply Profile screen.

The following is summary of each field on the screen.
Profile Name
This is the name of the profile.
Options
The following capture options are available.
Index

Selecting this option will cause items that are added to FileNet to be content indexed. This option
is only available for FileNet Content Services.
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Capture Email

If selected, the email will be added to the FileNet repository as a file. To select the format that
email should be added in, click the “Edit Email Format...” link.

Capture attachments as individual files

If selected, attachments will add to the FileNet as individual files. The same properties that are
assigned to the mailbox item will be assigned to the attachments with the exception of Title. The
Title property will be set to the filename of the attachment.

Leave/Remove Attachments From Email

Selecting the “remove” option will remove the attachment from a captured email in the FileNet
repository. If this option is not selected, the attachment will remain within the email. The email in
the mailbox is not affected by this option.

Declare as Record

If selected, an item added to a P8 Records Manager enabled repository will be declared as a
record.

Enable Shortcuts

Selecting this option will enable functionality to update the email in the mailbox to include
“shortcuts” to the email and attachments added to the document repository. To edit shortcut
options, click the “Edit Shortcuts Options...” link.

Document Indexing
The Document Indexing section describes how items will be indexed in the FileNet repository.
Class

This is the document class that should be used when adding items to the selected repository. All
document classes in the repository that the current user has access to are shown.

Link Captured Files

When using P8 Content Engine and the “Email” class (or a class derived from it) is selected as
the Class, if Link Captured Files is selected, captured email files will be linked to attachments.

Folder to file documents

This is the FileNet folder that items should be added to. To select the folder, click the “...” button
to browse or search the selected FileNet repository.
Property Mappings

Property Mappings are used to specify what values should be assigned to each Document
Repository Property when an email is archived using a profile. Each property mapping consists of
the following.

Repository Property

A list of document repository properties (including custom properties) configured
for the Document Class selected. A “*” next to the name is used to indicate
properties that are mandatory.

Value

This is the value to assign to each FileNet Property. Email properties that can be
assigned to the FileNet Property are shown in a combo box, as well any CVL or
pick lists. The email properties listed are dependent on the data type of the
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FileNet Property. For example, if a FileNet Property is a date, only date-related
email properties will be listed. The email properties are shown at the top of the
pick list in the combo box. Values for FileNet Properties can also be manually
entered in the field. See the section Multi-Value Properties for details on how
multi-value properties are handled. Note that property mappings containing
regular expression or calculated values can only be created in the Email
Manager Server Configuration utility. The following email properties are

available:

Email Property

Description

Attachment Count

The number of attachments in an email.

Attachment Flag

Indicates whether or not an item has
attachments.

Body Summary

The email body (first 254 characters).

CC Address

The address portion of the any entries that
appear in the CC field.

CC Address User Id

The user portion of any entries that appear in
the CC field.

CC Address/Display The address and display name of the any
entries that appear in the CC field.
CC Display The display name portion of the any entries

that appear in the CC field.

Conversation Topic

The conversation topic (original subject line)
of the item.

Email Id

The unique id of the item.

Email Server

The name of the email server that the email
resides on.

From Address

The address portion of the entry that appears
in the From field.

From Address User Id

The user portion of any entries that appear in
the From field.

From Address/Display The address and display name of the entry
that appears in the From field.
From Display The display name portion of the entry that

appears in the From field.

Originating User Id

The id of the user who initiates the capture of
an email.

Received Date (Local)

The received date of the item using the local
time.

Received Date (UTC)

The received date of the item using UTC time
(Coordinated Universal Time a.k.a.
Greenwich Mean Time).

Sent Date (Local)

The sent date of the item using the local
time.
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Sent Date (UTC) The received date of the item using UTC time
(Coordinated Universal Time a.k.a.
Greenwich Mean Time).

Subject The subject line of the item.

To Address The address portion of the any entries that
appear in the To field.

To Address User Id The user portion of any entries that appear in
the To field.

To Address/Display The address and display name of the any

entries that appear in the To field.

To Display The display name portion of the any entries
that appear in the To field.

Record Declaration

For P8 systems enabled for Record Manager use, the Record Declaration section will be enabled to allow
record declaration data to be entered.

File Plan Object Store
The file plan Object Store that the record should be declared in.
Record Class

This is the record class to use when declaring the record. Click the “...” button to select a record
class.

Classification

This is the classification(s) that should be used when declaring a record. To add a classification,
click the add classification button. To remove a classification, click the remove classifications
button.

Property Mappings

A list of Properties (including custom properties) configured for the record class selected. A “*”
next to the name is used to indicate Properties that are mandatory. The Record Declaration
property mapping section operates in the same way the Document Indexing property mapping
section operates.
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Advanced Options
Clicking the “Advanced” button will show or hide the “advanced” section of the screen.
Always Show Profile Before Adding To Repository

If this option is selected, when the Profile is chosen by the user when an item is selected for
adding to FileNet, the user will be prompted with the Profile details. This option may only be
updated when a profile is created. The fields that are shown when the user is prompted with a
profile may be configured by selecting one of the following options:

o Prompt for all fields: all fields in the profile will show.

o Prompt only for all empty fields: only fields in the profile that have not been
assigned a value will show.

e Prompt only for all empty required fields: only fields in the profile that are
mandatory and have not been assigned a value will show.

e Prompt only for all required fields: only fields in the profile that are mandatory
will show.

Share This Profile With Other Users

Selecting this option will make the profile available to users other than the user who created the
profile. This option may only be updated when a profile is created The Profile Security screen
(accessed by clicking the “...” button next to this option) may be used to specify what users or
groups have access to the profile.

Document Security

The Document Security section is used to specify the security that should be assigned to mailbox
items that are added to FileNet. Security privileges can be created based on Email Properties,
FileNet Users and FileNet Groups. For FileNet Content Services, default security may be
configured so it is based on the current user’s DIAL (Default ltem Access List).

Security privileges based on Email Property assign the indicated access level to all users whose
name appears in the Email Property selected (either To, From, or CC). Note: The Exchange
Server or Lotus Domino user name and the FileNet user name must be identical in order to take
advantage of this feature.

Security privileges based on FileNet Users assign the indicated access level to the FileNet user
specified.

Security privileges based on FileNet Groups assign the indicated access level to the FileNet
group specified.

To add Security privileges, select the type of the security privilege to add (Email Property, Users
or Groups), select the Name (an email property, user name or group name) and the access level
to assign to the item selected in the Name combo box. Click the Add button to add the Security
settings.

To update a Security setting, select an item in the Document Security grid. The Name and
Access Level will be populated with the data of the item selected. Change the name or Access
Level and click the Modi £y button. The item will be updated in the grid.

To remove a Security setting, select an item in the Document Security grid. The Name and
Access Level will be populated with the data of the item selected. Click the Remove button. The
item will be removed from the grid.

Note: the Add/Modify button will dynamically change depending on the mode the screen is in.
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The Document Security section consists of the following items:

OK Button

Document Security Grid

The Document Security grid shows all the access privileges that have been
created. The grid shows the Type of the access privilege (either Email Property,
User or Group), the Name (either the email property name, user name or group
name) and the access level assigned (either None, Viewer, Author, Owner or
Admin).

Email Property/Users/Groups Radio Buttons

When adding Security privileges, select the item that the access privilege will be
based on. Selecting Email Property will populate the Name combo box with a list
of Email Properties that security settings can be derived from (To, From, and
CC). Selecting Users will populate the Name combo box with a list of document
repository Users. Selecting Groups will populate the Name combo box with a list
of document repository Groups.

Access Level

The access level to assign to the item selected in the Name combo box. The
access levels that available may be limited by the system administrator. In
addition, the administrator may override access levels.

Selecting this button will cause the item(s) to be added to the FileNet repository using the Profile.

Cancel

Selecting this button will cancel the Profile creation or update process and close the screen.
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4.2 Multi-Value Properties

If a multi-value property is clicked on in the Property Mapping Grid, the Select Multi-Values screen will be
shown. In this screen, items may be added to or removed from the multi-value list.

?—}- Select Multi-Yalues [_ O]

Enter a Mew Yalue:

| fdd

all values: Selected Values:

Attachment Flag

CC Address

CC Address|Display

CC Display

Canversation Topic

Email Id

From Address

From Address|Display

Fram Display

Subiject

To Address

To Address/Display

To Display

Adriniskratar [Adriniskrakor@ybgdesy . com]
Ben Fredetickson [benf@ytgdey, com)
Dravid Gu [davidg@whbgdey.com])

EYE

ik, Cancel

Enter a New Value

If the multi-value property accepts user entered values, new values may be added to the Selected Values
list by entering them in the Enter New Value field and clicking the Add button.

All Values

Values that may be assigned to the multi-value property are shown in this list. Email properties that can
be assigned to the property are shown, as well any CVL or pick lists. The email properties listed are
dependent on the data type of the multi-value property. For example, if a property is a date, only date-
related email properties will be listed. The email properties are shown at the top of the pick list. To add a

value to the list, select the value and click the “>“ button.
Selected Values

This list shows all values that have been already been assigned to the multi-value property. The remove
an item from list, select the item and click the X button.
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5 MESSAGE VIEWERS

Email Manager captures email messages from Microsoft Exchange servers in the native (.msg) file
format. These saved messages can be opened and viewed using Microsoft Outlook.

Lotus Notes and Novell GroupWise do not have native file formats for individual mail messages. Email
Manager captures Lotus email messages as Domino XML (.DXL) files and GroupWise messages using
custom xml (.fngwentity) files. The Email Manager Client includes simple viewer applications to view
messages stored in these file types.

5.1 Domino XML (DXL) Viewer

The Domino XML (DXL) Viewer is a stand-alone client application for viewing DXL files and for importing
DXL files into Lotus Notes. The user interface is divided into two parts. The upper file selection list
shows recently opened DXL files and the lower preview pane shows the content of the currently selected
file.

Opening DXL files in the DXL Viewer
DXL files may be opened in the DXL Viewer in one of the following ways:
e From FileNet Workplace.
e From Windows using the file association.
e Dragging and dropping DXL files from Windows Explorer into the DXL Viewer file selection list.
o From the command line, passing the filename as a parameter.
e From the File, Open dialog in the DXL Viewer.

e Selecting a document in Lotus Notes and clicking on the DXL icon in the FileNet Email Manager
custom toolbar. The selected document is exported to DXL and opened.

Using the file selection list

The file selection list displays summary information about selected files and is used to switch between
files. By default, the file selection list is displayed in details view as a table with four columns, Subject,
UNID (Unique ID), File name and Location.

The information displayed in the file selection list is obtained from the file name, not the message content
and relies on Email Manager to name the file according to a specific naming convention. The subject
displayed in the file selection list is also limited to 60 characters and may differ from the message subject
if the subject contains characters that are not valid in filenames.

The following operations are available directly from the file selection list:
Display file contents in the preview pane

Click on a file in the file selection list to select the file and preview it in the preview pane using the
current preview formatting option.

Open afile in Lotus Notes

Double-clicking on a file selects the file and acts as a shortcut to the ‘Import into Lotus Notes...’
menu option. If Lotus Notes is open and connected to a Domino server, the DXL file will be
opened in Lotus Notes. See below for more information.
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Displaying the context menu
Right-click to display the context menu. See below for information on the menu items.
Viewing and resizing columns

In details view the columns can be resized. Clicking on a column header will automatically resize
the column to fit the data.

Menu Options

The main menu provides access to all DXL viewer functionality. Most menu options are also accessible
from the right-click context menu in the file selection list (see below).

File Menu

The File Menu is accessed from the DXL Viewer main menu. Most of the File menu options are also
available from the right-click context menu in the file selection list. This menu provides the following
options:

Open...

Opens the Windows file selection dialog to locate DXL files on the file system. The selected files
are added to the file selection list and the last file is displayed in the preview pane.

Preview As

Displays the ‘Preview As’ submenu to switch between display formats for the preview pane. This
submenu is also accessible from the right-click context menu. The available options are:

HTML — All

Displays the mail message, properties table and links/attachments table in the preview
pane as formatted HTML.

HTML — Mail Message

Displays the mail message in the preview pane as formatted HTML. This is the default
preview format.

HTML — Properties

Displays the properties table in the preview pane as formatted HTML. This table lists all
the items in the source Lotus Notes document.

HTML — Links/Attachments
Displays the links/attachments table in the preview pane as formatted HTML.
XML
Displays the DXL file as formatted XML.
Text
Displays the file contents as plain text.
Open As

Displays the ‘Open As’ submenu to control how the DXL document is opened. This submenu is
also accessible from the right-click context menu. The available options are:

HTML — All

Opens the file in Internet Explorer and displays the displays the mail message, properties
table and links/attachments table as formatted HTML.

HTML — Mail Message
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Opens the file in Internet Explorer and displays the displays the mail message as
formatted HTML.

HTML — Properties

Opens the file in Internet Explorer and displays the displays the properties table as
formatted HTML. This table lists all the items in the source Lotus Notes document.

HTML - Links/Attachments

Opens the file in Internet Explorer and displays the links/attachments table as formatted
HTML.

XML
Opens the file as formatted XML in Internet Explorer.
Text
Opens the file as plain text in Notepad.
Import into Lotus Notes...

If Lotus Notes is open and connected to a Domino server, selecting this option will import the
current document into the user’s Notes mailbox as a temporary document, then open it in the
Lotus Notes client. Because the user is already logged into Notes, no authentication dialog will
be displayed. The imported message can be forwarded or replied to, but not recaptured.

This option is also accessible from the right-click context menu. This option is not available if
Lotus Notes is not running and it may also be disabled by the administrator.

Exit
Closes the DXL Viewer.
Edit Menu

The Edit Menu is accessed from the DXL Viewer main menu. The edit menu options are also available
from the right-click context menu in the file selection list. This menu provides the following options:

Select All

Click to select all files in the file selection list. This option is used in conjunction with Remove
Selected to remove files from the file selection list.

Select None
Clears the file selection (does not effect the file that is displayed in the preview pane).
Remove Selected
Removes selected files from the file selection list.
Remove All
Removes all files from the file selection list.
View Menu

The view menu is available from the main menu and from the right-click context menu in the file selection
panel. The options in this menu are used to change the display format of the file selection list. The file
selection list is shown as a table by default, but may be viewed as:

Large Icons
Small Icons
List
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Details

Detalls view is the default format. The file selection list is displayed as a table with four columns,
Subject, UNID (Unigue ID), File name and Location. The columns can be resized and clicking on
a column header will automatically resize the column to fit the data.

Note: The information displayed in the file selection list is obtained from the file name, not the
message content. The subject displayed in the file selection list is limited to 60 characters and
may differ from the message subject if the filename does not conform to the Email manager
naming convention or if the subject contains characters that are not valid in filenames.

Help Menu

This menu contains one option, About that displays the DXL Viewer version.

5.2 GroupWise Entity Viewer

The GroupWise entity viewer is an HTML application that uses Internet Explorer to display formatted
GroupWise messages. The displayed information also includes extended message information in
expandable sections. Depending on the content of the message, these sections may include:

Message

The email message is displayed in the familiar email message layout, including the key message
properties such as sender, message date, recipients, subject and the message body.

Attachments

The attachment table is displayed if the message contains attachments and/or embedded GroupWise
messages. The attachment table lists the attachment names, filenames, types and sizes. The filenames
are displayed as hyperlinks. If the attachment is an embedded GroupWise message, clicking on the
hyperlink will open the attached message in another GroupWise Entity Viewer window. Clicking on a file
attachment hyperlink will open the attachment, either in the associated application or in Internet Explorer.
Opening attachments from hyperlinks is subject to the usual Internet Explorer security restrictions, and
may be blocked or may cause Internet Explorer security dialogs to be displayed.

Recipients

Expand the recipients table for additional information about message recipients, including the recipient
type (To, CC, BCC), email address and display name.

Sender

Expand the sender block for more information about the sender, including the email address and display
name.

Sharer

Expand the sharer block for more information about the sharer. The sharer is typically the sender, unless
the message was captured from a shared mailbox.

Properties

Expand the properties table for in-depth information about the email message, including message IDs,
creation and modification status, delivery status and more.

Fields

This section is present if the message contains extension fields. Expand the fields table to see the values
of all extension fields in the message. These fields may be added to the application by the administrator,
Email Manager and other applications.
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Reply Children

This section is present if the message is part of a message thread with one or more replies. Expand to
see the message IDs of all reply children of this message.

Autodate Messages

This section is present if the message is a task or appointment that will cause additional messages to be
sent at specific future dates. Expand to see the message IDs of all related autodate messages.
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